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Chapter 10 Overview

The focus of Chapter Ten is the automation of a few pages on your web server. Consider web pages for your staff.  It is reasonable to have a page with the links to each staff member’s web page.  It is also reasonable to have staff member’s web sites organized by school.  Imagine how much time it would take to update these pages every time a new staff member’s web site is added.  These updates can be taken care of through the use of Active Server Pages (ASP).  

By following the procedures in this chapter, you will load Active Server Pages that access a database, This same process can be used for student web pages.

You may find it necessary to frequently update news or other information on your districts home page.  When this information becomes out-dated, it requires the webmaster to physically remove the information.  Additionally, this information must be moved to an archive location or be permanently deleted.  Through Active Server Pages, this information can be posted on the district home page.  At a pre-determined date, the information will be automatically removed from the home page and placed on an archive page.

By following the procedures in this chapter you will set the folder permissions, copy the databases to the designated folder and create DSN connections.

The two database files used in this chapter require Access to 2000.  If possible, I recommend mapping into the E drive (web data drive) on your web server.  If this is not possible, you will need to install Access 2000 on your web server. It would be helpful to have a printer available for printing forms or reports.

	
	Activating Your Web Sites

	
	

	Setting folder Permissions for Data Access 
	Your Active Server Pages will be driven from data contained in a database file.  This file will be located on the same drive as your web data, however, it will require different permissions than your web data folder.

Note: You must log into the server as the administrator.



	
	

	
	1. Open the “E” drive (or the drive which holds your web data) on your web server.  Create a new folder then name this folder Data_Bases.


	
	[image: image1.jpg]| Fle Edt vew Fevonmss Tods rep =
| wgak + = - G| @oeach Chpoders Brsoy |05 68 X m| 7
| address [S 0 oo
= s See [Type.
=
'—’%L | Ciwet sics e Folde
-mk i ol
Web_Data (E:
Data_Bases
Fie P
Modified: 2{10/2001 2;07 PM
J e —
e 4 |
1 object(s) selected I 1 my Computer 7








	
	2. E:\ drive window:  Place the pointer over the Data_Bases folder.  Right mouse click, choose properties.


	
	[image: image2.jpg]= =lolx|
[P e o [
| eck - = - 1] @sowch Cypokies ey |05 03 X 0|
| aderess [ 1 =] Pw \
~1 B Size | Type
= u e ol
il Folde
Web_Data (E:) ;’:;;E
Data_Bases B
Rl Facer )
Modified: 2/10/2001 207 P T s
Attributes: (normal)
b — |
Displays the properties of the selected iters. B 7

Create Shortcut
Delets

Renane.







	
	3. Data_Bases Properties window /General tab: Click the Security tab.
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	4. Data_Bases Properties window / Security tab: Click Add…
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	5. Select Users, Computers, or Groups window:  Scroll and select the Administrators group.
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	6. Select Users, Computers, or Groups window:  Click Add, click OK.
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	7. Data_Base Properties window/ Security tab: Place the check mark in the Full Control check box under the Allow column.  The entire column will fill with check marks.  Click Apply.
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	8. Data_Base Properties window:  Select Everyone in the Name box.  Remove the check box to the right of Allow inheritable permissions from parent to propagate to this object.
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	9. Security alert window:  Click Remove.
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	10. Data_Base Properties window/ Security tab:  The Everyone group will be removed.
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	11. Data_Base Properties window/ Security tab:  Click Add…
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	12. Select Users, Computers, or Groups window:  Select Everyone. Click Add.
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	13. Select Users, Computers, or Groups window:  Click Ok.
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	14. Data_Base Properties window/ Security tab:  Click Apply, click OK.
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	15. E:\Data_Base window: Copy the following file from the Staff_Web_files folder located inside the ASP folder on the CD: staff_web.mdb.  Now, copy the staff_web.mdb database file into the Data_Bases folder.
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	Creating the Staff Web DSN
	

	
	1. Click Start, choose Programs, Administrative Tools, and click on Data Sources (ODBC).
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	2. ODBC Data Source Administrator window / User DSN tab:  Place your pointer over System DSN tab then click.
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	3. ODBC Data Source Administrator window / System DSN tab:  Click Add…
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	4. Create New Data Source window:  Select Microsoft Access Driver (*.mdb) click Finish.
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	5. ODBC Microsoft Access Setup window: In the Data Source Name: field, type Staff_Web.  In the Description: field, type Staff Web Database File.  Click Select.
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	6. Select Database window: Click the down arrow under the Drives: drop down box.


	
	[image: image21.png]Select Database

Datsbass Name

List Files of Type:

[Access Databases [ >

Ditectores

e Asdniistiator

— T
T,
B Adnrisn e
B Coogies I~ Read Onl
£ Desktop. Iy
S Favoier W
s

. Network








	
	7. Select Database window: Choose e: Web_Data.
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	8. Select Database window: Double click the Data_Bases folder under the Directories scroll box.
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	9. Select Database window: Select staff_web.mdb in the Database Name scroll box.  Click OK.
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	10. ODBC Microsoft Access Setup window: Click OK.
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	11. ODBC Data Source Administrator window / System DSN tab:  Click OK.


	
	[image: image26.png]21|
User SN  System DS | File DSN | Diivers | Tracing | Cannection Paoling | Abaut

System Data Sauices

Nare | Diver Add,
Wictosaft Acsess Dver (-]

Remove

Configure.

the ndicated data provider. A System data source i vible 0 al users

i An DDBC System deta souce stores nfoimation sbout how o cormect to
onthis machine, ncluding NT services.

Help

oK, Concel







	Copying ASP Data into the Staff Web Folder
	You now have a connection between the database and your server.  This will also allow you access this information through Active Server Pages (ASP)  

In the next 2 steps, you will copy the ASP files to your web server thus completing the connection between the web page and the database.


	
	1. Copy the following files from the Staff_Web_files folder inside the ASP folder on the CD:

· default.asp

· list.asp

· location.asp

· learniis_staffweb_banner.jpg

Copy default.asp, list.asp and location.asp to the root level of the staff_web folder on your web server.  

Copy learniis_staffweb_banner.jpg into the images folder on the web server.

2. Delete the default.htm file from the Staff_web folder on your web server.

	
	


	
	3. Open your web browser to your staff web site.  If this page loads, you are successful.
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	How this works:  Very simply stated, the Staff_web.mdb file is an Access 2000 database file that contains a list of Schools or locations and a list of staff members who have web pages.  These two tables are queried by the web page.  The content of these queries are displayed on the web page.  Each time a new staff member is added to this database, the web pages will show this change the next time the web page is loaded.  The same is true if a new school or location is added to the database. 

There are also several changes to make on the default.asp file copied to the staff web folder.  Those changes can be made using FrontPage. Change LearnIIS to match your district.  The webmaster e-mail link will need to be adjusted.  You will want to change the graphic at the top of this page.  Be aware of the far left table column.  This holds the ASP script.  You will want to be careful making changes to this area of the web page.

There are a few changes you will need to make in the Staff_web.mdb file to customize the information to your site.  Please follow the next set of procedures.

	
	

	
	


	Customizing the Staff_web.mbd file.
	Double click the Staff_web.mbd file located on the web server.  Note:  Access 2000 must be installed on the web server or your workstation must be mapped to the web server’s hard drive that contains the file.  Your workstation must have Access 2000 installed. 


1. Microsoft Access window / Staff_web.mbd file: Click the restore box in the minimized staff_web database window.
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	The Staff_web: Database window will display on your screen.
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	2. Staff_web: Database window:  Double click Location.
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	3. Location: Table window: Edit the list of Locations to match your district.  Add any additional locations. (Be sure to place an underscore “_” between the words.) Close this window when you are finished.
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	4. Open the Staff_info: Table 
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	5. Staff_info: Table:  Select Design View from the View menu.
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	6. Staff_info: Table:  Locate the Field Name URL.
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	7. Staff_info: Table: Select URL.  Place the pointer in the Default Value text field under field properties.  Edit the information to match your district’s staff web URL.
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	8. Staff_info: Table: Select the field name e-mail.  Place the pointer in the Default Value text field under field properties.  Edit the information to match your district’s e-mail domain URL.
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	9. Staff_info: Table: Select Datasheet View from the View menu.
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	10. Staff_info: Table: You will be returned to the Datasheet View.
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	11. Staff_info: Table: Select Select All Records from the Edit menu. 
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	12. Staff_info: Table: Select Delete Record from the Edit menu.
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	13. Microsoft Access alert window:  Click Yes. All entries will be removed.  Close Staff_info table.
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	14. Staff_web: Database window:  Minimize this window.
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	15. Microsoft Access window / Staff_web.mbd file: Select Enter a New User on the Main Switchboard.
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	16. Microsoft Access window / Staff_Web_Checklist_form: Change the references to LearnIIS on this form to match your district.  You will need to choose Design View from the View menu in order to make these changes. Note:  The text on this page is contained in text boxes.  Close this window when you have finished editing.
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	Entering a staff member into the database
	This procedure assumes the Staff_web.mbd file is open.

1. Staff_web database / Main Switchboard window:  Click Enter a New User.
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	1. Microsoft Access window / Staff_Web_Checklist_form:
Fill in the each field listed in this form.  
First Name:
Last Name:
User ID: You will need to make a decision on what naming convention to use for User ID.  First initial, Last name is widely accepted as the standard. Example: swheeler 
Password: 
Location: (Drop down box) The location will be drawn from the information placed in the location table.  
Phone:
URL: The URL contains the staff web URL. Do not remove this information.  Type the users First name then an underscore (_) then the last name behind the URL.
Example: http://staff_web.learniis.edu/Shawn_Wheeler 
e-mail:
Click the Print Record button on this form when finished. Close this window.
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	2. Staff_web database / Main Switchboard window:  Click Exit this Data Base.  Close Access.
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	3. The users information will now display on the Staff Web site the next time the page is loaded.

4. Retrieve the printout.  Follow the checklist procedures on this form.  Notice there are two separate checklists. One for a FrontPage web.  The other is for a web that will use FTP.  You may find it helpful to refer to chapters 4 and 8 the first few times you set up an account for a staff member.  The staff web site utilizes the sub web with FrontPage extensions or FTP access.  Directions on how to set up these two types of sub web sites are in chapter 8.  (Name the user folder on the web server First name underscore (_) Last Name (Example Shawn_Wheeler) just as you entered the information on this form.  This will ensure your link from the Staff Web home page to the users site will work. 

	
	

	
	


	
	

	Creating District News DSN
	1. E:\Data_Base window: Locate the following file from the folder Homepage_New_files folder located inside the ASP folder on the CD: district_news.mdb.  Copy the district_news.mdb data base file into the Data_Bases folder.
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	2. Click Start, choose Programs, Administrative Tools, and click on Data Sources (ODBC).
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	3. ODBC Data Source Administrator window / User DSN tab:  Place your pointer over System DSN tab then click.
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	4. ODBC Data Source Administrator window / System DSN tab:  Click Add…
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	5. Create New Data Source window:  Select Microsoft Access Driver (*.mdb) click Finish.
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	6. ODBC Microsoft Access Setup window: In the Data Source Name: field, type District_News.  In the Description: field, type District News Database File.  Click Select.
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	7. Select Database window: Click the down arrow under the Drives: drop down box.
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	8. Select Database window: Choose e: Web_Data.
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	9. Select Database window: Double click the Data_Bases folder under the Directories scroll box.
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	10. Select Database window: Select district_news.mdb in the Database Name scroll box.  Click OK.
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	11. ODBC Microsoft Access Setup window: Click OK.
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	12. ODBC Data Source Administrator window / System DSN tab:  Click OK.
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	Copying ASP Data into the District Main Web  Folder
	1. Copy the following files from the CD:

· default.asp

· fullstory.asp

· news_archive.asp

· learniis_staffweb_banner.jpg

Copy default.asp, to the root level of the District_Main_Web folder on your web server.  

Create a new folder in the District_Main_Web folder name the folder Data. 

Copy fullstory.asp and news_archive.asp to the Data folder.

Copy learniis_banner.jpg into the images folder.

2. Delete the default.htm file from the District_Main_Web folder on your web server.



	
	

	
	3. Open your web browser to your District Main web site.  If your page loads and you see the list of current events, you have been successful.

Place the pointer or the text LearnIIS Current Event Archives and click.
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	2. This page will display the all the past and present items in the News Database. Click the Back button on the browser.
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	3. Locate and click the text that reads For the full story, click here.


	
	[image: image63.png]| Be Edi Vew Faoile Lo He

| ook~ 5 - D (2] 2| Qsesen [irovates By |

[Adtess €1 s /rwoiai oau

elcome to Learn IIS
The Art of IIS

Current Events at LearnIIS

O of the mare cool festuras sbout this is the Fact that HTML code can be placed into the datsbaze.
When the server randers the page, the code uill be displayed 3 you wantad it to

Date Fosted 2/12/2001 Date to ba removed 12/31/2005

o the full story, chek here

frable Test | |
& tablas work if we were to lay them in?
ata Postad 2/10/2001 Date to be ramoved 12/31/2005
o the full story, chek heve

Bob Dole says Hello
ead Story
ata Postad 10/29/2000 Date to be ramoved 12/31/2005
o the ful story. cick here








	
	4. This page will display the full story that is posted News Database. Click the Back button on the browser.


	
	[image: image64.png][ Fie Edt Vew Favaies Took Hel

|| Liks £1PUSD E)Exchange E]Statneb E1EPA &]Twning 7]

| Eeack - - D [2) A | Quoeach CifFavries (HHisoy | 2

| e 1 v i sl 5020

‘The Full Story.

Date posted 2/12/2001

Will be removed 12/31/2005
Hyperlinks

In this example we have three links. Microsoft, Intel and AMD

Formatting also works. Bold, Italics and Underlined.

Return to LearnIS Main page

EiDoe







	
	How this works.  The district_news.mbd file is an Access 2000 database file that holds news you enter.  The news entry will contain a subject, a story lead and the full story.  In addition, news entry posting date and the date the posting will be removed.

When the home page loads, the ASP queries the database.  Any news entry that has a posting removal date beyond the current date will display.  Any posting whose posting removal date has past, will not display. The information posted on the home page contains the subject, the story lead and the date the story was posted along with the date the story will be removed.  This will also contain a link to the full story.  Clicking this link will open a new page that will display all the information about that particular entry.

The home page also contains a link to the archives page.  This page queries the database for all entries then displays the subject; the story lead and the date the story was posted along with the date the story will be removed and a link to the full story.  

Using this database and the corresponding Active Server Pages allows your web site to display information for a set period of time. When the pre-determined date arrives, the information will no longer display.  This allows the webmaster to work on other task, additionally the database maintains the past news items for future viewing.


	Customizing the District_News .mbd file.
	The last step to make the District_News.mdb database fully functional is to remove the existing data and replace it with your own.  Please follow the next set of procedures.

	
	1. Microsoft Access window / District_News.mbd file: Click the restore box in the minimized district_news database window.
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	2. District_News: Database window will display on your screen. Click Tables under the Objects list.
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	3. District_news: Database window: Double click district_news_data.
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	4. District_news_data: Table: This table will display on the screen.
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	5. District_news_data: Table: Select Select All Records from the Edit Menu.
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	6. District_news_data: Table Select Delete Record from the Edit menu.
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	7. Microsoft Access alert window:  Click Yes. All entries will be removed.  Close District_news table.  Minimize the District_news database window.
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	Inserting a News Item
	This procedure assumes the District_news.mbd file is open.

1. District_news: Man Switchboard window: Click Enter a new story.
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	2. District_news_data window:  Type the information you wish to place in your news story.  Be sure to enter the date in the xx/xx/xx format.  Subject and Lead will be displayed along with the date posted and the date to be removed on the district main page and the News Archive page.  All data will be posted on the Full Story page.  Press Enter to end or input the next story.   Close the window when all stories have been entered.


	Note:  HTML tags may be placed into the Subject, Lead or Data fields. For example <b>Valentines Day</b> typed in the Subject field would render Valentines Day on the web page.
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	3. District_news: Main Switchboard window: Click Exit this database.  Close Access.
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	4. Open your web browser to view the story you have just entered.
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